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type the building blocks in the text box below the autonumbering check box, or
you can add building blocks to the format by clicking on them in the list box. The
principal building blocks are described in Table 5.1.

Figure 5.18 The Numbering Properties group in the Paragraph Designer
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Figure 5.19 Anatomy of a numbering format
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Table 5.1 Numbering format building blocks
Code Meaning Example
n Arabic numeral 1,2,3,...
a lowercase alphabet a,b,c,...
A uppercase alphabet ABC, ...
r lowercase Roman numeral i, 1, iii, ...
R uppercase Roman numeral LIL 111, ...

The counter portion of the format is placed between angle brackets (<>). Other items,
such as text, punctuation, or tabs, are placed outside the brackets. The additional sym-
bols + and = are used inside the brackets to control how the numbering is updated: +
means update the counter by 1, and = means set the counter to the value that follows
the = sign. For example, <n+> means use Arabic numerals and update the counter for
each paragraph with the tag; <n=1> means use the number 1 for each paragraph
with the tag. A numbering symbol without a + or = sign, such as <n>, means don’t
update the counter value (use the value from the previous numbered paragraph).
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FrameMaker 4.0 includes two new symbols for controlling the counter: < > means
keep the counter value the same, but don’t display it, and < =0> means reset the
counter to zero but don’t display it. These symbols are useful as place holders in
complex formats using multiple counters, as will be demonstrated shortly.

The easiest format to create is a simple numbered list. The only format code this
requires is <n+>. ; this means use Arabic numerals followed by a period and a space
and increment the value with each new paragraph. We’ll call this format “List Item.”
This produces a result such as that in Figure 5.20. You could use Roman numerals or
alphabetic characters instead of Arabic numerals by substituting their codes for the n,
but the basic principle remains the same. Suppose, however, that you want to create a
second numbered list in the same document or chapter using the same format. If you
just tag the paragraphs in the second list with the List Item format, the second list will
pick up the numbering where the first list left off. You could create a different format
for the second list, and for each subsequent list in the document, but fortunately,
there is a more efficient approach. You need only create a new tag for the first item in
the list (we’ll call it, imaginatively, “First Item”) with the code <n=1>. . This format
resets the number to one. Apply this format to the first item in each subsequent list
and apply the List Item tag to all the remaining items in the list. You can create as
many simple lists in a document as you wish, using only these two formats.

Figure 5.20 A simple autonumbered list

1. Open both the document with the format you
want to copy (the source) and the document
in which you want to use the copied format
(the destination).

2. Click an insertion point in the source docu-
ment paragraph (paragraph format) or select
atextblock (character format) with the format
you want to copy.

3. Openthe Edit Menu and select Copy Special>
Character Format or Copy Special>Para-
graph Format, as appropriate.

4. If you are copying a paragraph format, click
an insertion point in the paragraph in the des-
tination document where you want to apply
the format; if you are copying a character for-
mat, highlight the block of text in the destina-
tion document to which you want to apply the
format.

5. Open the Edit menu and select Paste to apply
the format.
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You can use the Next  setting in the Basic Properties group to ensure
l that a First Item paragraph is always followed by a List Item paragraph.

SHORTCUT

Using Series Labels

The formats described above will work well for a series of non-overlapping lists,
such as the steps in a series of procedures to be performed in succession in a ser-
vice manual or instructional book. However, it will not work for numbered lists that
overlap. For this situation, you need to use a series label. A series label can be any
printing character followed by a colon. If it is included, the series label must be the
first item in the format. The purpose of the series label is to distinguish among dif-
ferent overlapping series in the same text flow. For example, you might want to
number figures, tables, and photographs in the same chapter or publication, with
the numbered items being freely interspersed in the layout, using formats such as
Figure <n+*>, Table <nt+>, and Photo <nt+>.If you don’t use series labels,
FrameMaker will simply update the counter once for each numbered item it finds,
producing a single continuous series of numbers for figures, tables, and photos
combined. However, if you use series labels, such as F:Figure <n+>, T:Table
<n+>, and P:Photo <n+>, FrameMaker will distinguish among the three formats
and maintain three separate numbered series.

A more complex task is to create the numbering formats for a standard outline.
The codes for the first four levels of a standard outline are shown in Table 5.2. An
outline must have formats for each level in the hierarchy, and the counters for each
level must be updated only when appropriate. This means that FrameMaker must
keep track of several different counters, updating the one that is currently dis-
played, while maintaining all the others. Here, the < > symbol is used to keep the
counters for the higher levels from being updated while the lower level is updated
and displayed. Hence, each level has one < > for each higher level. If the < > were
not included, FrameMaker would assume that all the formats belonged to a single
list, and the first three items would be I, B, and 3, rather than I, A, and 1.

Table 5.2 Numbering codes for a standard outline format

Code Function Example
<R+>. First level I
\t< D<A+, Second level A
\t\t< >< ><n+d>. Third level 1.

\t\t\t< >< >< X<atd>. Fourth level a.
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Placing the tab codes in a numeric format does not create the neces-
sary tab stops. They must be created using the Tab Stops option in the
Basic Properties group or the tab buttons on the Formatting Bar. You
could also use different left indents rather than tabs to align the differ-
N O T E entlevels of an outline.

A slightly different format is used for a legal or numeric outline, which attaches the
number from the higher hierarchical level to its subtopics (for example, 1.,1.1,,1.1.1,,
and so on.) The codes for this format are shown in Table 5.3. This format is also used
to number headings, figures, and tables in some technical publications. For additional
examples of numbering formats, examine FrameMaker’s outline templates.

Table 5.3 Formatting codes for a legal or numeric outline

Code Eunction Example
<n+> . <n=0> First level 1.0
<n>.<n+> Second level 1.1
<n>.<n>.<n+> Third level 1.1.1
<n>.<n>.<n>.<n+> Fourth level 1.1.1.1

Bulleted Lists

You can use an autonumbering format to create a bulleted list. You can also create
bulleted items by manually typing the bullet character and a tab, but using an auto-
numbering format offers the advantages of being able to quickly change the bullet
style or other aspects of the format, and to transform numbered lists or other for-
mats into bulleted lists and vice versa.

This simplest method for creating a bulleted list is to define a paragraph tag with a
numbering format that consists of just the bullet character code and the tab code
(\b\1t). To create a paragraph that “hangs” from the bullet, you must also use the
Basic Properties group to set a first line indent of zero and a positive left indent. Set
the first tab stop in the paragraph to the same position as the left indent. (Use this
same procedure for numbered lists that hang.) If you are going to mix bulleted lists
with body paragraphs that use a first-line indent, it is a good idea, design-wise, to
use the same figure for the left indent of bullet paragraphs and the first-line indent
of body paragraphs. In many cases, a one-em indent makes a good starting point. If
you’re using a side head format, (described earlier in this chapter) you can create
bullet lists with bullets that hang in the left margin by making the bullet list items
side heads with wide left indents.

If you don’t want to use the predefined bullet character, you can substitute any other
character that is available on your system. The Zapf Dingbats font offers many good
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choices, as do other decorative fonts. To use a character from one of these fonts as a
bullet, you must create a Character Format (described later in this chapter) with the
appropriate font and size. The format will appear in the Character Format list in the
Numbering Properties group. Type the character you want to use as part of the num-
bering format, then select the Character Format from the list box. The selected char-
acter format will appear in the text box above the list. For example to use the shaded
box character from the Zapf Dingbats font (Q), followed by a tab, type o\t in the
numbering format box, then select the Zapf Dingbats character format.

Advanced Properties

Don’t be put off by the name if you don’t consider yourself an “advanced” user—
this group of properties controls paragraph characteristics that are important to
the overall appearance and legibility of body type, namely hyphenation and word
spacing. It is essential to understand the effect of these characteristics and use them
correctly to obtain consistent, professional results.

Hyphenation

FrameMaker uses a combination of dictionary-based and rule-based hyphenation.
When it encounters a word that needs to be hyphenated, FrameMaker first looks
up the word in the spell-checker dictionaries. If the word is listed in one of the dic-
tionaries, FrameMaker uses one of the hyphenation points stored there. If the word
is not listed, FrameMaker applies a series of rules to select a hyphenation point. You
can also manually control hyphenation of selected words by inserting discretionary
hyphens and nonbreaking hyphens while you type (see Chapter 3), by suppressing
the hyphenation of selected words, or by altering the hyphenation points of words
in the spell-checker dictionaries (see Chapter 11).

In the Automatic Hyphenation area of the Advanced Properties dialog box (Figure
5.21), you can set the following hyphenation properties, in addition to turning
hyphenation on or off:

Figure 5.21 The Advanced Properties dialog box
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Max # Adjacent—selects the number of consecutive lines that can end in a hyphen.
Fewer hyphenated lines make body text easier to read, but may result in more loose
lines in justified text or a more ragged edge in left-, right, or center-aligned text.
The narrower the column for a given type size, the more consecutive hyphens will
be needed to avoid loose or ragged lines. For reasonably sized columns of body
type, a maximum of two consecutive hyphens is a good rule of thumb.

You may be used to a program, such as PageMaker or Ventura, that can
automatically flag loose lines. FrameMaker does not offer this feature,
‘ so you will have to keep an eye open for them. Look for lines that
stand out visually from the flow of body text because of excessive white

N 0 T E space between words.

Shortest Word—designates the shortest word length that can be hyphenated. The
higher the value, the fewer the words that may be hyphenated and hence the
greater the possibility of loose or ragged lines.

Shortest Prefix/Shortest Suffix—these two settings control the length of the short-
est syllable that can occur before and after a hyphen. As with the Shortest Word
option, increasing the value of either of these settings will tend to reduce the num-
ber of hyphens and increase the likelihood of loose lines or excessively ragged line
ends.

Language

This selection determines which dictionary FrameMaker uses to look up hyphen-
ation points. If you create documents that mix different languages and have the
appropriate foreign language dictionaries installed, you can select the appropriate
language to use in hyphenating any given paragraph. The Language setting is also
used by the spelling-checker for selecting the appropriate dictionaries when check-
ing multilingual documents.

Word Spacing

Word spacing, not surprisingly, is the space between consecutive words (here
FrameMaker has retained the conventional term). There are three settings here
which, in conjunction with the letter spacing (Spread) and hyphenation settings,
have a considerable effect on the spacing and overall appearance of paragraphs,
especially body text. The three settings—Minimum, Maximum, and Optimum—are
expressed as percentages of the standard spacing for the default font, which also
appears in the dialog box. The latter figure is a feature of the font and cannot be
easily altered by the user.

FrameMaker uses the Minimum, Maximum, and Optimum values in adjusting the
spaces between words in each line. The greater the range of values you give it, the
more flexibility it will have. How this is manifest depends on the type of alignment
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you have selected for the paragraph. In left-, right-, and center-aligned paragraphs,
a wider range results in less ragged line ends, whereas in justified paragraphs a
wider range results in tighter spacing and fewer loose lines (see Figure 5.22). An
additional setting, Allow Automatic Letter Spacing, affects only justified para-
graphs. When on, this setting allows FrameMaker to adjust the spacing between
characters in order to keep the spaces between words within the limits specified by
the Minimum and Maximum settings.

Figure 5.22 A paragraph set with several different word spacings

Justified—50/100/150

The right of the people to be secure in their
persons, houses, .papers, and effects,
against unreasonable searches and sei-
zures, shall not be violated, and no War-
rants shall issue, but upon probable cause,
supported by oath or affirmation, and par-
ticularly describing the placeto be searched
and the persons or objects to be siezed.

Justified—100/100/100

The right of the people to be secure in
their persons, houses, papers, and
effects, against unreasonable searches
and seizures, shall not be violated, and
no Warrants shall issue, but upon proba-
ble cause, supported by oath or affirma-
tion, and particularly describing the place
to be searched and the persons or
objects to be siezed.

Left Aligned—50/100/150

The right of the people to be secure in their
persons, houses, papers, and effects,
against unreasonable searches and sei-
zures, shall not be violated, and no War-
rants shall issue, but upon probable cause,
supported by oath or affirmation, and par-
ticularly describing the place to be
searched and the persons or objects to be
siezed.

Left Aligned—100/100/100

The right of the people to be secure in
their persons, houses, papers, and ef-
fects, against unreasonable searches and
seizures, shall not be violated, and no
Warrants shall issue, but upon probable
cause, supported by oath or affirmation,
and particularly describing the place to
be searched and the persons or objects
to be siezed.

Frame Above Y/Below 1

This option is used to attach reference frames to selected paragraphs. Reference
frames contain frequently used graphic or textual elements, such as rules, icons,
ornaments, or special headings, that are stored on reference pages. The available
reference frames for the document can be selected from pop-up menus and
attached either above or below the selected paragraphs. For information on creat-
ing reference frames, see Chapter 4.
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Table Cell Properties

The final group in the Paragraph Designer, Table Cell Properties, applies only to
tables, and will therefore be reserved for Chapter 20.

Character Formats

Character formats behave similarly to paragraph formats, except that they are
applied to individual characters, words, or phrases, rather than to entire paragraphs.
The most obvious uses of character formats are to emphasize selected words with
type variations such as boldface or italics and to apply attributes such as superscript,
subscript, or underline. You can also use a character format to apply a special font
such as Symbol, Zapf Dingbats, or a decorative or technical Pi font.

The Character Designer

The Character Designer (Figure 5.23) has also been renamed and redesigned in
FrameMaker 4.0. It is much simpler than the Paragraph Designer, consisting of
only one group. In fact, the Character Designer is identical to the Default Font
group in the Paragraph Designer, and all of the options perform in exactly the
same manner as described above, so we won’t duplicate that information here. Sim-
ilarly, the Apply and Update All buttons and the Command menu work the same
way as those in the Paragraph Designer.

Figure 5.23 The Character Designer
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Creating Flexible Character Formats

If you want a character format to change only one or two aspects of the text that it
is applied to (as is usually the case), set the Character Designer to As Is using the
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option on the Command menu, then set only the characteristics you want the for-
mat to change. This way, you won’t have to revise your character formats whenever
you change some property of the paragraphs they reside in. It will also allow you to
use your character formats on a variety of different types of paragraphs, rather than
having to create lots of different formats for use in special cases.

Suppose, for example, that your body text font is 11-point Times Roman. If you
wanted to use boldface for emphasis, it would seem logical to define the Emphasis
character format as 11-point Times bold. This would be okay, provided you intend
to use the format only in body paragraphs and you never decide to change the fam-
ily or size of your body type. But suppose you decide later to change your body type
to 12-point Adobe Garamond. When you apply the new paragraph format to your
body paragraphs, you will be asked whether to remove or retain overrides. Since
you don’t want to lose your emphasized characters and other character formats,
you choose to retain your overrides. The result is that you now have body text in 12-
point Adobe Garamond regular, with emphases in 11-point Times bold. Not what
you want. Now you have to go back and redefine your Emphasis format as 12-point
Adobe Garamond bold (you can’t change it to As Is at this point, because that
would just cause it to remain 11-point Times). And you will have to re-edit the for-
mat (and any others you defined along the same lines) every time you change the
Body paragraph format.

If you use the As Is setting when you first create the Emphasis format, then all the
other characteristics of the emphasized characters will change appropriately when
you change the Body paragraph format. This works even when the font family uses
a different name for boldface, though, of course, it will not work if you don’t have a
boldface version of the font installed on your system. Use the same technique for
any other character format you use to apply a single variation, such as subscript,
superscript, italic, small caps, or the like, and you’ll spend far less time fooling with
character formats. This not only allows you to change paragraphs that have charac-
ter format overrides and have the formatted characters change appropriately, it
also allows you to use the same character formats in paragraphs with different type-
faces or sizes.

Using a character format to select a non-text font, such as Symbol or
Zapf Dingbats, is a bit tricky if the characters to which you are applying
‘ the format have ANSI codes higher than 0126 (see Appendix 1 for a
complete listing of characters and their ANSI codes). If you type the
N 0 T E character(s) first and then apply the format, the wrong characters will
appear and frustration will likely ensue. To get the right characters,
you must apply the character format at the insertion point first, and
then type the ANSI codes.
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If you select all the text in a paragraph, including the paragraph mark (%)

at the end and apply a character format, you will change the Default

‘ Font properties of the paragraph format to match those of the of the

character format. To change the character format of an entire para-

N 0 T E graph without changing the paragraph format, select all the characters
in the paragraph except the paragraph mark.

Using Formats from Other Documents

In addition to using the formats that you have created in a particular document or
inherited from one of FrameMaker’s templates, you can borrow a few formats or
even a whole catalog from another FrameMaker document. This applies equally to
Paragraph Formats and Character Formats.

If you want to use only a few formats from another document, the easiest approach
is to copy the format from one document and paste it in the other:

1. Open both the document with the format you want to copy (the source) and
the document in which you want to use the copied format (the destination).

2. Click an insertion point in the source document paragraph (paragraph format)
or select a text block (character format) with the format you want to copy.

3. Open the Edit Menu and select Copy Special>Character Format or Copy
Special>Paragraph Format, as appropriate.

4. If you are copying a paragraph format, click an insertion point in the para-
graph in the destination document where you want to apply the format; if
you are copying a character format, highlight the block of text in the desti-
nation document to which you want to apply the format.

5. Open the Edit menu and select Paste to apply the format.

Copying a single paragraph or character format into a document
doesn’t automatically add that format to the catalog in the destination
‘ document. If you want to add the new format to the catalog, you must
open the Paragraph Designer or Character Designer, as appropriate,

N 0 T E and follow the procedure described earlier in this chapter for storing a
new format in the catalog.

You can also import all the Paragraph and/or Character formats from another doc-
ument or template, along with many other characteristics:
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1. Select the Import>Formats option from the File menu.

2. A dialog box like that in Figure 5.24 will appear. Check the aspects of the
document you want to import, that is, paragraph formats and/or character
formats. Be sure to check only the appropriate characteristics; otherwise, you
might drastically revise every aspect of your document in one fell swoop.

Figure 5.24 The Import Formats dialog box
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3. Open the list box that says “Current,” meaning the document that’s cur-
rently active, and select the document from which to import the formats
(you can only select a document that’s currently open).

4. Click the Import button to import the selected formats from the source doc-
ument into the catalog(s) of the destination document, where they will be
added to the existing formats.

The formats from the source catalog will replace formats in the desti-
nation catalog with the same name. If you’re not careful, this might
‘ cause unforeseen results where formats of the same name exist in both
catalogs. Since the operation of importing the formats is not undo-
N 0 T E able, it’s a good idea to save your document immediately before per-
forming this operation, so you can revert to the saved version if

something goes awry.

Formatting Characters on the Fly

In addition to creating and applying character and paragraph formats, Frame-
Maker allows you to perform limited text formatting using three commands on the
Format menu: Font, Size, and Style. The Style option duplicates several of the

RS
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choices found in the Character Designer and the Default Font Properties group in
the Paragraph Designer: Plain, Bold, Italic, Underline, Double Underline,
Strikethrough, Overline, Change Bar, Superscript, and Subscript. To use these com-
mands, a block of text must be highlighted.

Six of the buttons in the Text Editing group on the Quick Access Bar affect text for-
matting:

k| Plain text (the default font for the paragraph)

Bold text

Underlined text

Italic text

Increase type size by one point

Decrease type size by one point

You can also set paragraph alignment, tab stops, and line spacing with the buttons
on the Formatting Bar.

Use these formatting methods for occasional, one-of-a-kind format changes. In
most cases, it is preferable to use paragraph and character formats, as they ensure
consistency throughout a document or family of documents and make it easy to
change all occurrences of a particular format.






